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一、欢迎使用

ESAPRO 2.1 是一款功能强大、操作简单，基于时间轴编程的灯光控制软件。它可以实时输出灯光控制信号，

所见即所得，通过调节参数，将可以直接控制灯具效果，提升灯光调试的实时和精确性。源于第一代软件

DMXPRO 多年的市场和项目应用经验，我们进一步优化，并增加了很多新的功能：如 16Bit 调光、HSB 色彩模

式、脱机 Art-Net、图层叠加、实时亮度调节、逻辑触发场景等。通过该软件，你可以控制所有基于 DMX 的设备

和灯具，如单色 LED、RGB、RGBWY、光束灯、水纹灯、激光灯、音乐喷泉、音乐播放器等。

ESAPRO 2.1 支持 WIN10 / MacOS 操作系统，并通过 USB / 网线与脱机主控制器连接。编好程序之后，可

以一键下载到控制器内，从而实现自动运行、定时、UDP 中控、APP 控制、传感器交互控制等。

1. 视频教程

 下载与安装 ESAPRO 2.1

ESAPRO 2.1 安装过程中，可以不安装 SSL 灯库文件，后续可以复制或按灯具参数自定义灯库。

 语言切换与界面介绍

ESAPRO 2.1 的多语言切换，主界面说明，以及通道值实时显示、3D 离线模拟、灯库模块。

 安装本地灯库软件与灯库升级包

下载、安装本地灯库软件，自定义各种 DMX 设备。灯库升级包，有 DMX 音乐播放器，DMX 视频播放器与

LED 灯串，射灯等灯库（动态更新）

 编写 RGBW LED 程序的一般步骤

添加 RGBW LED，编写静态、动态、Mapping 矩阵效果，并一键下载到灯光控制器，实现脱机使用。

 添加灯具、调整布局与灯具分组

新建项目文件，添加不同的灯具，并调整布灯图，进行灯具编组。

 音乐与灯光同步控制

添加、配接音乐，选择音乐文件与设置渐入渐出播放

 单通道 DMX 设备控制

喷泉水泵，升降球电机，单色 LED 灯串，体育球场投光灯的动态控制。

2. 主要特点

 时间轴编程

不同的灯具，有各自的时间轴。还可以给时间轴增加调光曲线，并采用图层叠加的方式，编写更丰富的效果。

 多种颜色模式

除了 RGB，RGBW，还支持 RGBWY 等多色模式。并支持 16Bit 的精细调光，让灯光效果更加平滑、细腻。

 多种 LED 规格

软件支持所有的 LED, 单色, 双色温, RGB, RGBW, RGBWY。并可以同时控制它们，实现项目的设计要求。

 自定义灯库

http://www.cqiled.com/cn/product/esapro2.html
http://www.cqiled.com/cn/product/dmxpro.html
http://www.cqiled.com/cn/product/esapro2.html
https://www.bilibili.com/video/BV1894y1Z7Re
https://www.bilibili.com/video/BV1V5411D7iq/
https://www.bilibili.com/video/BV1t541117aB/
https://www.bilibili.com/video/BV1US4y117pQ
https://www.bilibili.com/video/BV1RL4y1V7Vo/
https://www.bilibili.com/video/BV1RL4y1V7Vo/
https://www.bilibili.com/video/BV1RL4y1V7Vo/
http://www.cqiled.com
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通过灯库模块，可以创建并控制所有的 DMX 设备：LED, 光束灯，激光灯，水纹灯，音乐喷泉等。

 音乐时间轴

导入音乐文件，软件将在时间轴上显示频谱，对照频谱编程，可以更快地完成音乐灯光秀项目。

 脱机控制

将编好的程序，一键下载到 DMX 控制器内，就可以自动运行，自动循环。并可以通过 UDP 中控，APP，传

感器实现互动控制。

 定时控制

可以设定日期、时间，自动运行指定的灯光程序。也可以根据时区，日出/日落进行自动调节。

 多种控制协议

软件可以通过 USB/网线连接灯光控制器，不论联机/脱机，都支持输出 DMX, eDMX, Art-Net 灯光信号。

 内置效果与导入素材

软件内置了多种灯光程序，调节参数就可以编好效果。另外，还可以输入文字，PNG，MP4，MOV 等文件。

 3D 离线编程

在 3D 模块中，可以参考现场搭建场景，编好的程序，将在 3D 场景中实时预览，方便离线编程。

3. 新特性

基于 DMXPRO 的多年应用，ESAPRO 2.1 增加了很多新的特性，相对于 DMXPRO 其主要更新有：

3.1 时间轴

混合编程：在同一个场景上，既可以用常规灯光效果，又可以使用矩阵框映射效果，同一个通道，还可以在多

个时间轴上编程，极大地增强了程序的可编辑性，便于创建更丰富的灯光效果。

图层叠加：在 ESAPRO 2.1 中，增加了很多新的灯光效果。编程时，相同的灯具通道，还可以通过图层叠

加，像图形、视频软件一样，组合出新的效果，极大地丰富了灯光效果。

调光曲线： 编好的场景，可以添加一个调光曲线，从而实时调节整个场景的亮度，并且，还可以增加亮度节

点，曲线变化。除此之外，还可以增加透明度，颜色，调线等曲线，给灯光调试带来更多可能。

复制时间轴： 编好的时间轴效果，可以直接复制给其他灯具使用。也可以添加/删除灯具，而不需要从头开始

设置，这一改变，极大地提升了现场调试的方便性。

静态效果：在时间轴上，可以很方便地将一个动态效果转换成静态效果，勾选选项之后，将静止显示动态效果

的第一个画面，在一些特殊的项目要求下，这将非常有用。

3.2 接口与连接

 新一代的灯光控制器，都开始转向 USB Type-C，更方便现场工程师使用。

 主要设备参数，将可以通过局域网进行查看、设置，而不需要连接 USB 线。

 在 ESAPRO 2.1 中，你可以随时建立 / 移除与控制器之间的连接，而不需要重新打开软件。

 在 ESAPRO 2.1 中，结合几款控制器，不论是联机，还是脱机状态，都可以输出 Art-Net 网络灯光信号，

控制更远的灯具。

http://www.cqiled.com/cn/product/dmxpro.html
http://www.cqiled.com/cn/product/esapro2.html
http://www.cqiled.com/cn/product/dmxpro.html
http://www.cqiled.com/cn/product/esapro2.html
http://www.cqiled.com/cn/product/esapro2.html
http://www.cqiled.com/cn/product/esapro2.html
http://www.cqiled.com
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3.3 其他新特性

 TCA 高级触发功能，可以实现时间触发与干接点触发相结合，加上逻辑判断，可以实现更多意想不到的触

发效果，实现更高极的互动灯光控制。

 干接点触发更灵活，既可以单独设置干接点接口，又可以任意组合，通过可视化界面将更直观显示。

 音频输入，结合几款控制器，可以检测输入音频，从而让灯光随着音乐变化，自动切换效果。

 对于开机状态，既可以设置需要的场景，也可以默认黑场、或者恢复断电前的场景状态。

 软件界面可以放大/缩小了，对于使用高分辨率的电脑，将更为方便。

 ESAPRO 2.1 不仅支持 Windows 系统，还增加了 MacOS 系统，对于设计师来讲，带来更方便的选择。

 对于室内照明，我们增加了 16Bit 调光，HSB 调色模式等更多的控制方式。

4. 系统要求

安装 ESAPRO 2.1 ，需要具备如下条件的计算机：

 Windows 10 64 位以上

 Mac OSx 10.13 (High Sierra)以上

 多核处理器

 显示器分辨率不低于 1280x768(建议 1920x1080 以上）

 4GB 以上的内存（建议 8GB 以上）

 3D 离线编程功能，需要强大的 Open GL 3.2 图形处理显示功能（1GB 以上的显存，建议 2GB 以上），不

建议集成显卡的电脑使用 3D 离线编程功能

5. 下载 ESAPRO 2.1

5.1 下载链接

​ 可通过以下链接，下载 ESAPRO 2.1 软件、灯库编辑器及扩展灯库。软件可用于 Win10, MacOS 系统，只

需下载对应的版本即可：

 下载地址 1

 下载地址 2

5.2 恢复安装包

由于不同浏览器的保护机制不同，有可能出现下载软件之后，打不开安装包，不能安装的问题。

(1) 工具栏的下载图标，将会显示一个感叹号，点击这个图标

(2) 点击 esapro2.exe 右边的按键"更多操作"

(3) 在弹出的窗口中，选择"保留"

http://www.cqiled.com/cn/product/esapro2.html
http://www.cqiled.com/cn/product/esapro2.html
http://www.cqiled.com/cn/product/esapro2.html
https://vip.123pan.cn/1769971/dmxsoft/esapro21.exe
https://pan.baidu.com/s/1c25UqR3QufQEn3cDyfWhgg?pwd=dmx8
http://www.cqiled.com
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选择"显示详细信息"，选择"仍然保留"。

选择之后，浏览器将恢复文件。这时点击"打开文件"，就可以进行软件安装。也可以在下载文件夹中，找到

"esapro21"安装包，进行软件安装。

http://www.cqiled.com
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6. 安装 ESAPRO 2.1

打开安装包，将开始安装 ESAPRO 2.1

选择安装目录时，建议安装在 "d:\ESAPRO21" 文件夹内，将默认的 C 改为 D 即可。需注意：安装路径不得

有中文。

安装过程中，需要选择安装组件。其中，"SSL files"是软件自带的灯库文件。如果勾选，将从服务器下载安

装，一般情况下，可以无需安装灯库文件。

安装过程中，将会提示安装灯光控制器的驱动程序，点击"Next"进入安装即可。

http://www.cqiled.com/cn/product/esapro2.html
http://www.cqiled.com
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软件将自动安装 Microsoft Visual C++ 运行库，点击安装即可。如果你的电脑已经安装了更高版本的运行

库，将出现设置失败的提示，点击安装，继续安装程序。

待安装完成，点击 "Finish" 结束安装。

安装完成之后，可以在桌面找到 ESAPRO 2.1 软件：

http://www.cqiled.com
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7. 安装灯库编辑器

ESAPRO 2.1 可以兼容所有的 DMX 设备，对于没有灯库的设备，我们需要用灯库编程器来自定义灯库(SSL2

格式)。点击以下链接，就可以下载灯库编辑器：

 下载地址 1

 下载地址 2

下载完成，解除浏览器的锁定功能，将获得灯库编辑器的安装包：

双击运行 SSL2Editor.exe，将弹出如下界面：

建议将软件安装在默认的”D:\SSL2Editor”文件夹内，确定好文件夹之后，点击”Extract”即可完成安

装。安装完成之后，从桌面点击 SSL2 Editor，就可以打开灯库编辑器。

8. 升级安装 ESAPRO 2.1

ESAPRO 2.1 软件，不支持覆盖安装。安装新版本之前，需要先将旧版本卸载，再重新安装。卸载之前，需先

备份特殊的灯库文件：

灯库文件，位于文件夹，如：D:\EsaPro21\ScanLibrary 下：

 _cqiled：包含 DMX 音乐播放器等特殊灯库；

 _custom：包含自定义的灯库文件，如单色 R，单色 B 等；

http://www.cqiled.com/cn/product/esapro2.html
https://vip.123pan.cn/1769971/dmxsoft/SSL2Editor.exe
https://pan.baidu.com/s/13-p5w4DPz9GfK3OkzrTLtQ?pwd=dmx8
http://www.cqiled.com/cn/product/esapro2.html
http://www.cqiled.com
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二、ESAPRO 2.1 界面说明

1. 主界面

1.1 主菜单

主要用于打开文件，调用 DMX 通道参数，切换显示语言等常规功能。目前常用的几个功能为：

主菜单 子菜单 功能

File 文件 New (CTRL+N) 新建工程文件

Open (CTRL+O) 打开工程文件

Recent files 最近的工程文件

Save (CTRL+S) 保存工程文件

Save As 另存工程文件

Quit 退出软件

http://www.cqiled.com
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主菜单 子菜单 功能

Edit 编辑 Undo (CTRL+Z) 撤销动作

Redo (CTRL+Y) 重复动作

View 视图 Editor 编辑 打开编程窗口

StandAlone 脱机 打开脱机下载界面

Simulator 现场模式 现场表演模式，可从工具栏切换

Tools 工具 3D Visualizer 3D 离线模拟，用于离线编程，效果模拟

Hardware Manager 硬件管理器，用于修改固定 IP，校正时钟，测试输出等

Profile builder 在线灯库编辑，国外服务器，需登录

DMX Levels 查看 DMX 输出参数，可以查看当前程序的每一个通道值

Settings 设置 System location 软件的使用位置，用于 Cloud 云控功能

Reset default dialogs 恢复默认对话框，包含连接设备等窗口

Import device 连接设备，用于打开设备连接窗口，选择连接的设备

Edit color values in% 以百分比方式显示 DMX 参数，切换 0-255 或者 0-100%

SUT Dialog 智能升级窗口 Always display at startup

Promotional offers only

DEMO mode or Warnings only

Size ratio 界面的缩放比例，用于不同分辨率的显示器

Enable High DPI scaling 激活高清显示比例

75%~200%

Language 语言 English / 中文 用于切换显示语言，达 20 种

Help 帮助 About / License 关于软件

1.2 工具栏

Editor 编辑

用于编辑、预览灯光场景，编程的主要工作界面

Stand Alone 脱机下载

用于将编好的灯光程序下载到控制器中

Simulator 现场模式

用于现场控制、模拟场景的自动运行效果

3D Visualizer 3D 模拟

用于搭建 3D 场景，配置灯具，离线编程，预演灯光效果

Devices 连接设备

用于搜索、连接可以连接的设备
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1.3 Zone 分区

主要用于创建和设置分区，在同一个项目中，可以把不同的灯具分在不同的分区中。每个分区，可以编写自己

的灯光场景。分区的场景，可以独立运行，互不影响。在 ESAPRO2.1 对应的网络脱机控制器中，最多可以设置

20 个分区。

 Global 为默认分区，也是主分区，可以控制所有的灯具，如果没有创建新的分区，则只有一个分区

 RGB 为第一个子分区，Kinetic 为第二个子分区

 ，可以点击这个按钮创建新的分区，双击分区名，可以修改新的名称

配接好灯具之后，首先选中 Global 主分区，再选中灯具，将可以在属性窗口中，指定灯具 (4) 所在的分区。

注意 1：

一个工程文件中，一个灯具可以同时存在两个分区：主分区 Global 以及灯具分区(如上图的 RGB 分区 )

注意 2：

除了主分区，点击其他的灯具分区时，只有属于该分区的灯具，颜色才是深色，可编辑状态。其他分区的灯

具，将处理浅色，不可编辑状态。

1.4 Builder 配接灯具

用于添加、配接灯具、进行灯具的布局等基本操作。

(1) Add lights 添加灯具

用于添加灯具，分配 DMX 域，设置地址码。

http://www.cqiled.com
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单通道灯具：一般用于单色灯具的静态场景，较少使用

RGB/RGBW：最常用，可以自定义颜色顺序，通道数量

LED 灯带：看项目需求使用

LED 矩阵：看项目需求使用

DMX 继电器：用于 DINA-DR1 的 DMX RELAY 接口控制

DALI 灯具：用于 DINA-DR1 的 DALI 接口控制

Add Other：配接其他灯具，添加自定义的灯具，常用

Patch 配接：用于分配 DMX 域，根据地址码设置灯具。

(2) Lights 灯具列表

灯具列表窗口，显示了项目中所有的灯具，并包含以下信息：

 DMX 域 ：上图最右侧的 -1， -2，代表了第一个域，第二个域

 DMX 地址 ：上图所示的 187, 190, 193...

 灯具名称：如 rgb, w-led

(3) 灯具位置

在位置窗口，显示了所有灯具的图形，位置。在位置窗口，可以将灯具按照项目现场进行排列，以便直观地根

据现场情况进行灯光效果编写。

(4) 布局工具

主要用于对灯具进行选择、排列，对齐，放大/缩小等操作。比较重要的几个工具：

 Custom Matrix 自定义矩阵

这个工具主要用于矩阵排列，可以快速地，按照一定规则，对所有灯具进行快速排列。选中灯具后，再点击这

个工具，将弹出高级位置对话框。

 数字 1，代表第一个灯的位置

 箭头方向，代表了地址码的走向，按现场的灯具走向选择合适的选项即可

 Size，可按需要设置不同的行列组合
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 Snap 贴齐

用于手动排列灯具时，可以方便对齐灯具

 Scale to fit 显示所有灯具

用于缩放窗口，以显示所有灯具

1.5 Selections 编辑常规灯光效果

用于创建灯具分组，创建场景，并使用内置效果、时间轴编写灯光效果。

(1) 灯具分组

Add 添加分组: 为选中的灯具创建一个分组，后续编程时，只需选中这个分组名称，就可以快速选中灯具。

删除分组: 删除已经编好的灯具分组

(2) 灯具效果

在灯具效果窗口中，将会实时显示正在运行的灯光效果，以方便查看输出状态。

(3) 内置效果

在 ESAPRO 2.1 中，内置效果，主要分为五大类：

 Basic 基本效果

 Pixel 动态 LED 效果

 X/Y 光束灯摇头位置

 Color 矩阵灯光效果

 Special 特殊效果
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1.6 Mappings 编辑矩阵灯光效果

用于将灯具当作显示屏，创建矩阵灯光效果。在矩阵模式下，拥有更多、更丰富的灯光效果，并且还可以输入

文字，导入图片或者视频，直接用于控制灯具。

注意：该效果只能用 RGB 通道，如果需要用于其他灯具，请咨询技术工程师。

(1) 矩阵列表

矩阵列表中，将显示已经创建的矩阵。选中一个矩阵，就可以对该矩阵进行编程。

 Rename 重命名 ：修改矩阵框的名字

 Lock/Unlock 锁定/解除锁定 ：锁定矩阵框，防止移动其位置，或者误删除

 Delete 删除 ：删除不需要的矩阵框

(2) 灯具与创建矩阵

在灯具显示区域，将显示灯光当前运行的灯光效果。在其工具栏上，还可以创建不同的矩阵框，并对灯具进行

放大，缩小，方便查看。

 Selection 选中矩阵 ：选中需要编效果的矩阵框

 Rectangle 添加方形矩阵框 ：在需要做矩阵效果的灯具上方，画一个方形矩阵框。矩阵框覆盖的灯具，

将显示矩阵效果。

 Add Circle mapping 添加圆形框 ：画一个圆形矩阵框，用于矩阵效果

 Add Polygon mapping 添加多边形框 ：画一个多边形框，用于矩阵效果

(3) 矩阵效果

矩阵效果库中，拥有更丰富的内置效果，并且这些效果拥有更多的参数，比如调节跑动的方向，旋转角度等。

1.7 Properties 属性

用于设置选择对象的属性，可以对灯具进行分区，修改场景名称，修改时间轴的显示方式，修改控台的脱机参

数等。选择不同的界面，不同的对象，这里将显示不同的属性内容。

1.7.1 灯具属性
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选中灯具后，在右边的属性窗口，将显示灯具的属性：

 Name, 修改名称

 Size, 灯具尺寸，方便

 Shape: Round 圆形，Rectangle 长方形，Square 方形

 Zone：设置分区

同时，在属性窗口中，还会显示选中灯具在布灯图的位置，灯库文件，DMX 地址(选择单灯时)

1.7.2 场景属性

选中场景后，将显示场景的属性，其主要参数为：

 Name, 修改名称

 Zone, 场景所在的分区

 Duration，场景的时间长度，可以点击修改时长，注意：场景的时长不能小于时间轴的时间长度

 Fade In，场景的渐入时长，默认为 0，修改之后在切换时，将渐入场景

1.7.3 时间轴属性

在时间轴管理窗口选中时间轴后，将显示时间轴的属性，其主要参数为：

 Name 时间轴名称： 在编写灯光秀或者复杂效果时，自定义名称将帮助你快速的找到时间轴。

 Blending Type 混和模式： 默认情况下，处于上方的时间轴将覆盖下方的时间轴。采用混和模式，将可以

通过一定的算法，融合出新的，更多的灯光效果。
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1.7.4 效果块属性

在时间轴上，选中一个效果块，属性窗口中将显示效果块的属性：

 Name：修改效果块名称

 Duration：效果块的持续时间

 Start time：效果块的起始时间

 End time：效果块的结束时间

 Fade In：渐入的时间长度，默认为 0

 Fade Out：渐出的时间长度，默认为 0

 Loop number：效果块的循环次数，默认为 1

 Custom loop：自定义循环次数，勾选之后，上面的 Loop number 将跟着改变。其含义是指在效果块的

总时长内，这个效果将循环运行几次。如果循环 2 次，则灯光变化速度将加快一半

 Link Entry/End Points：保持起点/终点的参数一致，用于添加亮度、调相等参数曲线时，如果勾选，则起

点和终点将保持相同的参数

 Static block：静态效果，勾选之后，可以把动态效果转为静态效果，效果将保持第一个画面状态，相当于

暂停状态
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1.8 My Project 场景列表

用于添加、复制、删除、重命令场景，也可以用于调节场景顺序，并显示场景的总时长，以及预选择要把哪些

场景用于脱机控制。

(1) Add Scene： 创建一个新的场景

(2) Add Dali sequence： 创建 DALI 灯具的场景。

(3) 修改场景顺序：用鼠标左键按住列表左边的 3 个小点，并向上/向下移动，可以修改场景的顺序。

(4) Pre-Select for Stand Alone： 激活的场景将出现在脱机场景列表中，默认为激活状态(深色)，如果取消

激活，在脱机场景列表中将不显示该场景。

(5) Lock/Unlock 锁定/解除锁定：锁定场景的时间轴，防止误修改。

(6) Copy ：复制场景

(7) Paste ：粘贴场景

(8) Delete 删除场景：通过右下角的删除图标，或者在场景上点右键，选择"Delete" 可以删除不需要的场景。

(9) 修改场景名称：双击场景名称，或者点击右键，可以修改场景名称。注意：场景名称，需使用字母或者数

字，不要使用中文。

(10) Duplicate 复制场景：在场景名称上点击右键，选择 "Duplicate"，可以复制当前场景。

1.9 Timeline 时间轴

在时间轴列表中，可以创建时间轴，图层，导入音乐或者绘制矩阵框。在工具栏上，可以播放/预览场景，也

可以设置单独场景预览播放。

(1)(3) 跳转到上一个 / 下一个效果块
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(2) Play/Pause 播放/暂停场景

(4) Loop 循环播放：激活之后(蓝色图标)，循环播放效果。否则，播放一次场景之后，将停止播放

(5) Snap 贴齐：时间轴上的效果块，将自动贴齐

(6) Allow block overlap：激活后，在时间轴上拉动效果时，将自动裁剪被覆盖的效果

(7) Avoid block overlap：激活后，效果之间不覆盖，只是贴齐

(8) 滚动条：拉动滚动条，可以显示时间轴的不同区域。按住并拉动滚动条左右的圆，可以

放大/缩小时间轴

(9) 展开/收起时间轴的高级功能，对于音乐轴，可以查看音乐波形；对于其他效果，则包含：

 Opacity 透明度：如果同一个灯只有一个时间，则相当于亮度

 Phasing 相位调节：调节动态效果的变化参数

 Saturation 饱和度：调节 LED 颜色的饱和度，参数越高，则颜色会越接近白色(默认为 0)

(14) Active/deactive 启用/禁用时间轴：关闭眼睛图标之后，将禁止这个时间轴的效果输出

(15) Lock/Unlock 锁定/解锁时间轴：锁定时间轴之后，将不能修改时间轴的效果，参数

修改时间轴层级：按住时间轴名称，并上下移动，可以修改时间轴的层级位置，相同的灯具，将显示位于上方

的时间轴效果

时间轴列表右键菜单

 Delete (Del)：删除时间轴

 Rename：重命名时间轴

 Duplicate：克隆当前时间轴

 Targets：添加/移除时间轴的灯具

 Current targets：控制当前选中的灯具

 Add selected fixtures: 添加选中的灯具到当前时间轴

 Remove selected fixtures: 从时间轴移除选中的灯具

 下方将显示灯具分组，便于快速选择灯具

 Show targets：显示当前时间轴控制的灯具
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2. 脱机下载界面

脱机下载界面，主要有以下功能：

 选择要脱机运行的灯光场景，并写入到脱机控台内

 可以将控台内的程序读回到软件上，再编辑，修改

 设置场景的循环、跳转方式

 设置脱机控台的端口输出方式，输出的 DMX 域

 添加干接点、定时以及其他多种触发方式，激活"TCA" 触发设置窗口

 配接联机/脱机 Art-Net 输出的设备 IP 及 DMX 域

通过主菜单"View > Stand Alone" 或者工具栏的按钮 ，都可以切换到脱机下载界面。

脱机下载界面主要包含以下内容：

(1) Devices：连接的控台列表

(2) My project：所有的场景列表

(3) Zones：分区列表(选择分区之后，在属性栏修改启动的状态：指定场景，黑场、恢复断电前场景)

(4) 分区场景列表，脱机程序列表(包含场景名称，时间长度，循环次数，调整顺序、删除脱机场景)

(5) Properties：属性栏，设置主控参数，以及进入触发设置界面

(6) Outputs：输出端口，设置主控每个端口的 DMX 域，以及添加 Art-Net 输出

(7) Calendar：日历窗口，设置了定时的那一天，将显示一个小圆点

(8) Synchro: 同步窗口，用于设置多机联动同步 (部分型号)
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3. 配接窗口

选择了灯库之后，将弹出配接窗口。

(1) 左侧的灯具列表，显示的是还没有配接的灯具。

(2) 右侧的 DMX 地址窗口中，显示已经配接的灯具、编号，DMX 地址码。

(7) 如果需要使用第二个 DMX 域，则在中间点击 (7)增加域按钮+Universe 即可。

一般情况下，有 3 种配接灯具的方式：

 可以点击"(6) Automatic Patch"，自动完成 DMX 配接

 选择本配接的域 (3) Universe，并选择 (4) 第一个 DMX 地址 First Address，点击 (5) 配接 Patch 。

 也可以从列表窗口，选中一个灯具，直接 拉到右边的 DMX 地址窗口中，指定的 DMX 地址码即可。

注意：配接灯具之前，需要先知道现场的灯具地址码。上面的配接操作，并不能改变灯具的参数，如果是

RDM 的灯具，需要使用 RDM Manager 进行查询与修改。

当你配接好灯具之后，将鼠标移到 DMX 地址窗口中，停留在灯具上，将显示灯具的序号，DMX 域 ，地址

码。点击已经配接的灯具，将会输出信号，点亮这个灯，对于项目调试，将非常有用。

http://www.cqiled.com/cn/product/rdm-manager.html
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4. DMX Levels

通过主菜单"Tools > DMX Levels"，可以打开 DMX levels 窗口，在这个窗口，将会显示 DMX 域，以及各

个 DMX 通道的输出状态。如果出现灯具不能正常控制的情况，可以通过这个窗口检查程序是否正确，输出参数是

否符合要求。
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三、其他模块

1. 灯库编辑器

使用灯库编辑器，你可以根据通道表，创建你自己的灯库文件。ESAPRO2 软件使用 SSL2 格式的灯库文件。

在编辑器中，你可以添加调光、光闸、颜色、XY、图案以及棱镜等常见的 DMX 灯具通道。

安装了增加灯具包之后，可以在"D:\EsaPro2\Scanlibrary Editor"文件夹中打开灯库编辑器

详细的灯库编辑说明，请查看编辑器的说明书。请注意：

 如果在灯光编程之后，要更新灯库，则需要重新配接灯具，并需要将编好的效果复制到新的灯具上。

 如果是经常使用的灯具，建议可以细化灯库，使编程更方便。

 创建灯库前，需要选择正确的灯具类型。如果灯具类型不对，可能会影响编程使用。

2. 硬件管理器 Hardware Manager

通过 硬件管理器，你可以对 DMX 网络脱机控台进行升级，也可以用来测试 DMX 输出，以及校正时间，设

置 IP 地址，下载脱机测试程序等。

可以在主菜单"Tools > Hardware Manager"打开，也可以在文件夹"D:\EsaPro2\HardwareManager"中打

开。

http://www.cqiled.com/cn/product/hm.html
http://www.cqiled.com
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3. 3D 模拟器

通过 3D 模拟器，可以实时显示编好的灯光节目，更立体地显示现场的灯光效果。从而，实现离线编程，加速

灯光项目地调试进程。

可以在主菜单"Tools > 3D Visualizer"或者工具栏打开，也可以在文件夹"D:\EsaPro2\EasyView2"中打开。

http://www.cqiled.com
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4. RDM Manager

RDM Manager (Remote Device Management)，可以在现有的 DMX512 信号线路上，对 RDM 灯具进行

远程设置，比如远程编写 DMX 地址，调整 DMX 参数等。目前，我们的 RDM 管理器支持 Windows/Mac 系

统，并通过连接相应的 USB-DMX512 控制器，对 RDM 灯具进行设置。

http://www.cqiled.com/cn/product/rdm-manager.html
http://www.cqiled.com
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四、建筑灯光控台

1. CQ-CE42 网络脱机控台

 1024 个 DMX 通道, 可升级到 2048 通道，XLR3 卡侬接口

 UDP 中控，16 路干接点(可组合)、时钟/日历控制，TCA 增强触发控制，干接点逻辑控制

 兼容 LED、双色温、RGB、RGBW、RGBWY、舞台灯、染色灯、激光灯、喷泉（可自定义灯库）

 99 个场景，10 个快速场景按键，5 个分区，每个分区可单独控制，互不影响

 Windows, MacOS 编程与 iOS, Android 远程控制

 电脑时间轴编程，不同灯具独立控制，实时预览灯光效果

 内置效果丰富，可以导入视频，文字等内容显示

 一键脱机下载控制

 兼容 RDM 远程设备管理

 通电自动循环，上电记忆

 3 种安装结构：螺丝、DIN 导轨、1U 机架式

2. CQ-CE31 导轨式网络脱机控台

 512 个 DMX 通道, 可升级到 1536 通道，螺丝端子

 UDP 中控，8 路干接点(可组合)、时钟/日历控制，TCA 增强触发控制，干接点逻辑控制

 兼容 LED、双色温、RGB、RGBW、RGBWY、舞台灯、染色灯、激光灯、喷泉（可自定义灯库）

 99 个场景，5 个分区，每个分区可单独控制，互不影响

 Windows, MacOS 编程与 iOS, Android 远程控制

 电脑时间轴编程，不同灯具独立控制，实时预览灯光效果

 内置效果丰富，可以导入视频，文字等内容显示

 一键脱机下载控制

 兼容 RDM 远程设备管理

 通电自动循环，上电记忆

 DIN 导轨安装方式

http://www.cqiled.com/cn/product/cq-cm42.html
http://www.cqiled.com/cn/product/cq-ce31.html
http://www.cqiled.com
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3. DINA-DR1-Lite 导轨式网络脱机控台

 1024 个 DMX 通道, 可升级到 3072 通道，XLR3 卡侬端子

 支持扩展，脱机输出 Art-Net 通道，实现远距离，光纤网络控制

 UDP 中控，16 路干接点(可组合)、时钟/日历控制，TCA 增强触发控制，干接点逻辑控制

 兼容 LED、双色温、RGB、RGBW、RGBWY、舞台灯、染色灯、激光灯、喷泉（可自定义灯库）

 20 个分区，每个分区可单独控制，互不影响

 Windows, MacOS 编程与 iOS, Android 远程控制

 电脑时间轴编程，不同灯具独立控制，实时预览灯光效果

 内置效果丰富，可以导入视频，文字等内容显示

 一键脱机下载控制

 兼容 RDM 远程设备管理

 通电自动循环，上电记忆

 DIN 导轨安装方式

4. CQ-CM42 音乐灯光二合一控台

 1019 个 DMX 通道, 可升级到 2043 通道

 96 首音乐文件, SD 卡存储

 时间轴编程, 实现脱机音乐灯光秀

 触发方式：UDP 中控, APP, DMX 控台, 干接点触发, 定时

 兼容各种 LED：单色、色温、RGB、RGBW

 兼容各种 DMX 灯具：光束灯、染色灯、激光灯

 通电自动循环，上电记忆

 10 个快速场景按键，5 个分页，99 个场景

 RDM 远程设备管理

 iOS / Android APP 控制

 TF 卡保存灯光节目

 螺丝安装、DIN 导轨安装、1U 机架式安装

http://www.cqiled.com
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五、控制 DMX 灯具的一般步骤

1. 新建工程文件

打开 ESAPRO 2.1 时，将自动创建新的工程文件。也可以通过主菜单"File > New (CTRL+N)"创建工程文件。

注意：保存工程文件时，文件路径或者文件名，不得使用中文。

2. 配接灯具

配接灯具，需要在工具栏，切换到"Editor 编辑界面"，并选择"Builder"窗口

3. 修改灯具分组

4. 调整 LED 布局

5. 编辑常规灯光效果

编辑灯光效果，通常有两种方式来完成：

(1) 选中灯具，再将内置效果块拉到灯具上，软件将自动生成新的时间轴。

(2) 如果已经有时间轴，也可以将效果块拉到时间轴上，打开编辑窗口修改参数。这个方法，也适用于需要在

一个时间轴上，添加多个效果的情况。

6. 添加矩阵框效果

7. 选择脱机场景

8. 设置开机启动场景

9. 脱机下载

http://www.cqiled.com
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六、场景脱机与触发设置

网络脱机控台，在脱机状态下，可以采用多种方式来切换灯光场景：按键、传感器干接点触发、定时触发、

UDP 中控触发、APP 触发。这些触发方式，它们的层级是平等的，后操作的为准。如果有必要，也可以通过高级

触发功能（TCA）进行条件设置，可以设置成：当满足一定的条件之后，比如到了时间才允许传感器触发，或者在

什么时间段不允许触发等。

1. 开机默认场景

脱机控台的开机状态有 3 种方式：

 Last played scene：恢复关机前的状态，初次设置后，脱机控台显示为”A--”

 Blackout：黑场，开机之后，脱机控台显示为”A--”

 Set scene：指定一个开机场景

其设置方式为：在脱机下载界面

(1) 点击连接的脱机控台

(2) 选择要设置的 Zones（分区），一般为 Global（总分区）

(3) 在属性面板中，点击 Starting scene 的下拉框，选择想要的开机状态即可

2. 场景循环与跳转

如果要场景结束后，自动跳转到另一个场景，如：灯光秀结束后自动回到场景 1（待机模式），需要设置：

2.1 设置循环次数

在脱机界面，选择分区中场景名称，如上图的 (3)，再设置 (4) Loop number 为 1，并勾选 (5) Release at

end，设置完成后，在场景列表(3)中，在 Loop 选项下，将显示相应的循环次数。

http://www.cqiled.com
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2.2 设置场景跳转

在脱机界面 (1)，选中脱机控台 (2)，并在右侧的属性栏，找到触发(3)，并点击 None set, 如果已经设置了其

他触发，这里将显示触发数量，如 2 triggers

在弹出的窗口”Advanced trigger / TCA”窗口中，按以下操作：

(1) 选择”Scene: About to stop”，并添加到 TCA 列表中；

(2) 选择要执行这个触发条件的场景，这里是要在场景 2-Rainbow 结束之后，回到待机状态，所以在 Item

中，选择”Global”分区的”2-Rainbow”;

(3) 当上面的条件满足之后，进行场景跳转”Start scene”;

(4) 选择要跳转到的目标场景，这里是”Global”分区的场景”1-On”;

设置完成后，点击”OK”回到脱机界面，这时，再选择主控台，属性窗口中，将显示”1 trigger”。

http://www.cqiled.com
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3. 干接点触发场景

干接点触发，是一种简单，常用的触发方式。通过干接点，可以连接多种传感器来触发场景，比如红外感应，

开关，触摸按钮，光线传感，红外对射，声音触发等各种方式，通过这些组合，可以实现灯光的交互控制，带来更

有智能好的灯光控制效果。使用时，一般将干接点调成：触发一下就断开，不需要一直触发。

3.1 连接干接点

干接点，也就是不带电源的接点。如上图所示，将传感器的 GND 与控台的 GND 连接。并将传感器的信号线

与主控制器的 P1 连接即可。上图添加了两个传感器，分接接入 PORT1, PORT2。

3.2 控制逻辑

做干接点触发时，一般是设置一个待机场景。干接点触发新的场景后，运行一定的次数，自动回到待机场

景。这里，我们需要设置场景的循环次数，以及跳转方式。请参考场景跳转。

3.3 添加单个干接点

(1) 选中主控制器，添加触发（Triggers）

(2) 在弹出的窗口”Advanced trigger / TCA”窗口中，按以下操作：

 选择”Port: Released”，并添加到 TCA 列表中；

 选择合适的端口，将其点成绿色 状态。而其他不需要的端口，则点成空白状态

 在 Actions 下面，设置 状态为 Scene > Start scene，即切换一个场景。

 选择要切换的目标场景，这里是”Global”分区的场景”2-Rainbow”;

 注意：通过干接点切换场景之后，如果要回到待机状态，就一定要添加”About to Stop”，并跳转。

http://www.cqiled.com
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干接点有 3 种触发方式，可以按需要进行选择，一般常用的是 Port: Released。

 Port: Released，断开干接点时

 Port: Pressed，接通干接点时

 Port: Held，干接点一直接通时

3.4 添加组合干接点

需要执行多个干接点同时触发才有效的项目时，需要使用组合干接点。使用组合干接点时，除了需要的端口设

为绿色 之外，其他的必须设为空白 。

4. 定时触发场景

 添加时间触发

 添加特殊日期触发

 使用电池

 校正时钟

http://www.cqiled.com


ESAPRO 2.1 | 动态灯光软件

2023/08/15 www.cqiled.com 35 / 47

5. UDP 网络触发场景

 设置固定 IP 地址

 发送 UDP 指令

6. 高级触发组合(TCA)

http://www.cqiled.com
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七、操作实例

1. 音乐灯光同步

音乐灯光同步，也就是脱机音乐灯光秀，实际一键音乐灯光同步控制的效果，主要用于展厅、文旅灯光项目、

音乐灯光装置等项目。使用 DMX 脱机控台，连接 DMX 音乐播放器，并通过编程，实现音乐灯光同步播放。

DMX 音乐播放器

实现脱机音乐灯光秀，主要有以下几个步骤：

1.1 配接音乐播放器

DMX 音乐播放器占用 5 个 DMX 通道，可以通过拨码开关来设定其起始通道。默认起始通道为 1，拨下拨码

开关为有效，一般建议地址为：480 (拨码 9+8+7+6，即 256+128+64+32)。

在 ESAPRO 2.1 的 Builder 界面，选择"Add Other "，并找到灯库"_cqiled \ DMX Music Player

2.ssl2"，如果没有，可到 官网下载灯库，并复制到”D:\EsaPro21\ScanLibrary\_cqiled”文件夹。

在配接窗口中，按照上面的参数，设置 DMX 音乐播放器的起始地址。

1.2 在 ESAPRO 2.1 导入音乐文件

在 ESAPRO 2.1 的时间轴上，添加音乐轴，导入音乐文件，编写、预览音乐灯光秀

http://www.cqiled.com/cn/product/cq-dmp5.html
http://www.cqiled.com/cn/product/cq-dmp5.html
http://www.cqiled.com/cn/support/cqiled-ssl2.html
http://www.cqiled.com
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(1) 在 Selections 界面，找到 Audio 效果 ，并拉到时间轴上，找到指定的音乐文件。(支持 MP3,

WAV 等格式)；

(2) 在时间轴上，点击 Timeline 左侧的展开按钮 ，将显示音乐文件的波形；

(3) 可以拉动音乐文件，以调整播放音乐的起始时间。

1.3 编写音乐播放程序

音乐播放器，可以调节音量，播放/暂停，单曲播放，循环播放。

(1) 使用时，将 拉到音乐播放器上。

(2) 在 Features 窗口中，将显示音乐播放的所有通道。点击右边的”+”键，分别添加”VOL 音量”，

“PLAY 播放”，”歌曲序号”

 VOL 通道，用于调节播放器的输出音量，一般调到 100%；

 PLAY 通道，用于控制播放功能，包括 播放， 暂停， 停止，一般调为播放即可；

 Music1，对应第一个文件夹”001”，包含 32 首歌曲，即可以选择歌曲编号 ，也可以循环播放文件

夹 ，循环播放可用于播放背景音乐模式。

(3) 编程时，音乐时间轴必须填满整个音乐长度，没有音乐时间轴的地方，将停止播放；可以点击播放效果

块，在属性栏的”Duration“选项下，直接修改其长度，也可以在效果块的右侧，拉动效果块，直到填满整个时

间轴。
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ESAPRO 2.1 | 动态灯光软件

2023/08/15 www.cqiled.com 38 / 47

1.4 保存音乐文件

音乐播放器使用 SD 卡存储音乐文件，使用时，需按以下步骤复制音乐文件：

(1) 在 SD 卡的根目录（比如 G 盘），建立文件夹，取名为 01，或者 02，03，最大 3 个；

(2) 打开 01 文件夹，将要播放的歌曲，复制进去。

(3) 歌曲名需以 001-032 开头，并在后面加入自定义名称，每个文件夹下的歌曲名都是从 001-MP3 开始；

001 开头的，代表第一首歌曲；

002 开头的，代表第二首歌曲

1.5 注意事项

 联机编程，预览灯光效果时，音乐直接从电脑输出，而不是从音乐播放器输出；

 音乐播放器，只适用于脱机播放时使用，也就是编好程序之后使用；

 音乐播放器，自带功放为 3W，4 欧姆，如果要接大功率音箱，需要外接功放。
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2. 控制明瑞像素 LED 控制器

不论是建筑亮化、文旅灯光项目还是展厅、圣诞树等项目，很多项目都大量使用点控的像素 LED。这种情况

下，要实现将像素 LED，音乐播放器，喷泉，舞台灯等设备联动，就需要加入专门的像素 LED 控制器，扩展 LED

通道，实现大面积 LED 与其他灯具的联动控制。

采用这种应用方式，一般需要分两次做灯光效果。

1. 使用第三方软件和系统，调试像素 LED ，并做好灯光节目，保存到 SD 卡；

2. 设置好第三方的主控制器的控台参数，接入网络脱机灯光控台；

3. 使用 ESAPRO 2.1 软件，编写其他灯具的灯光效果，并调用第三方 LED 主控制器的节目。

2.1 控制系统图

2.2 设置 D2TCP 的切换模式

 可以按照习惯方式和使用要求来设置 D2TCP 的切换模式，一般情况下，可以用 MODE 1

 设置 D2TCP 之前，需要将其他设备关闭，防止误设置

 使用遥控器，按 "MENU" 键，进入模式菜单选项，按左右键选择 MODE 1(即模式 1)， 按保存"OK" 键即

可完成设置。
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 再连续按两次"MENU" 键，进入参数设置

 FROM 001，代表的是起始通道

 TO 010，代表的是最大场景数

2.3 配接单通道灯具

在 ESAPRO 2.1 的 Builder 界面，选择”Add Single-Channel”，添加单通道灯具。灯具的数量可以根据项

目的实际情况来定，第一个灯具为速度，第二个灯具为节目 1，第三个灯具为节目 2...，也就是数量为 N+1。

2.4 编写 LED 切换程序

(1) 在 Selections 界面，选择要控制的灯具，将 Basic block 效果拉到这个灯具上；

(2) 在 Features 面板，在通道 Single 的 Dimmer 属性后面，点击加号(3)，添加调光效果；

(4) 在弹出的窗口中，点击 Dimmer Linear ，点击 OK，这时候灯具点亮，控制器将切换到指定的程序。

2.5 注意事项

 生成脱机场景时，需选择"分页生成文件"；

 做灯光秀时，时间轴上的时间要与 LED 主控场景时间一致。没有 Basic block 的地方，DMX 输出为 0，

将会切换成其他场景。

http://www.cqiled.com
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3. 快速点亮、测试灯具

在项目现场，快速点亮、测试指定灯具，是一个很实用的功能，可以在 "Patch 配接" 界面，依次选择：

1. 勾选"Light up selected fixtures 点亮选定的灯具"

2. 选中要点亮、测试的灯具 (按住"CTRL+鼠标左键"，可以点亮多个灯具，或者按住鼠标左键，框选所有灯

具，直接点亮所有灯具)

3. 在布灯图区域，对应的灯具将处于点亮状态，现场的灯具也会跟着点亮

4. 设置网关，多机同步

使用多功能网关，可实现一主多从的控制方式，同步控制若干个网络脱机控台，实现更多种类灯具，更多数量

灯具通道的灯光场景同步控制。

4.1 添加网关灯库

网关只需要 1 个 DMX 通道，就可以发出 30 条同步指令。出厂时，网关的 DMX 地址，已默认设为 511。网

关的灯库文件，可以通过我们的 网站下载，并保存到文件夹”D:\EsaPro21\ScanLibrary\_cqiled”内。保存之

后，在 ESAPRO2.1 的 Builder 界面，通过 Add Other，将网关的灯库添加到工程文件，并将其 DMX 地址

码，配接为 511 即可。配接完成之后，可以选中该设备，并在属性栏，将其开关改为 长方形 Rectangle

http://www.cqiled.com/down/ssl2/cqiled/dmx-udp.ssl2
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4.2 场景中添加网关参数

(1) 在编程界面 Selections 中，选中布灯图中的网关，从内置节目中，选择 Basic block，并拉到网

关上。将在时间轴上自动生成网关的时间轴效果。

(2) 生成时间轴后，在参数标签 Features，点击 DMX-UDP 的添加按钮 ，将弹出对话框，用于选择需要控

制场景参数。

(3) 将同步指令的长度设为 1 秒，这样，每次进入这个场景，都会进行同步，以确保所有脱机控制器的时序一

致性。
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4.3 添加空白动态效果

在 ESAPRO2.1 软件中，为保持同步程序的准确性。需要在不选中灯具的情况下，将一个动态效果”Rainbow

“拉到下方的空白时间轴上。

5. 快速编程控制水纹灯

http://www.cqiled.com
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八、常见问题与解答

1. 打开软件时，显示 no Qt platform plug?

打开 ESAPRO 2.1 软件时，出现如下提示"This application failed to start because no Qt platform plugin

could be initialized. Reinstalling the application may fix this problem." 出现这个问题，是因为 ESAPRO2 软

件的安装文件夹或者路径有中文名称。卸载软件，再重新安装到 "D:\ESAPRO21" 文件夹即可。

2. 打开软件，显示没有连接控制器？

1. 在 ESAPRO 2.1 软件的工具栏，有一个设备(Devices)工具，点击这个按钮 ，打开”Device import”窗

口，显示已经连接的控制器；

2. 点击对应控制器后面的激活选项"Active"，就可以连接控制器，进入联机控制模式；

3. 如果在输入设备"Device import"窗口中没有显示控制器，则需要检查：

 如果是 USB 连接，可以在文件夹”EsaPro2\driver\SiudiDriver.exe”，安装驱动程序；

 如果是网线连接，则可以通过 Hardware Manager，检查控制器的 IP 地址跟电脑是否同一个网段；

3. 脱机之后，控制器显示为 OFF，或者"---"？

1. ESAPRO2 的场景名称，不能使用中文，建议用英文或者数字；

2. ESAPRO2 的安装文件夹，工程文件名称，不能使用中文；

3. 在脱机下载前，需要将指定一个开机默认场景。请参考开机默认场景

4. 脱机节目，不能写到电脑上？

http://www.cqiled.com/cn/product/hm.html
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有时候，我们需要将脱机节目写到电脑上，再发送给项目现场，进行节目升级。如果出现上面的错误提示，其

原因是：文件夹或者路径有中文，即使放到桌面也不行，建议可以在 D 盘新建一个文件夹"SD"，在 ESAPRO 2.1

软件中，将保存路径选到 "D:\SD"，即可。
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九、附录

1. 内置效果

Basic 基本

Pixel 动态

X/Y

Special 特殊

Color 矩阵

1.1 基本效果

适用于各种 DMX 通道，一般用于整体效果，单色，整体变色等。新的 Paint 绘画功能，将允许你手动创建想

要的变化效果。

效果 参数

静态值

静态值，可以用于所有的通道。

 RGB: 灯具名称

 Red/Green/Blue: 对应灯具的每一个通道。不同的灯具，这里的通道名称，数量都

不相同

http://www.cqiled.com
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 Generic: 通用功能

 Color: 选择颜色

 Pan/Tilt: 对应电脑摇头灯的 X/Y 轴

 Dimmer：总调光，适用于所有灯具

画图

1.2 动态 LED 效果

一般用于控制 RGB 彩色灯具，实现各种跑动效果。

1.3 X/Y 光束灯摇头位置

主要用于摇头灯，电脑灯的 XY 动作控制。

1.4 矩阵灯光效果

主要用于 RGB 灯光矩阵，将 LED 当作显示屏，可以有更多的控制参数，比如方向，角度等。

1.5 特殊效果

包含导入音乐文件，编写音乐灯光联动控制。以及 DMX 继电器控制功能。

2. Blending Type 图层混合模式
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